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Abstract

This document leads you through the efficient use of the u-center Evaluation
Software, the powerful and easy to use tool from u-blox for evaluating and

testing GPS receivers.
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| Preface

Overview

u-center is u-blox’ powerful GPS evaluation and visualization tool which can be downloaded free-of-charge from
our website (http://Awww.u-blox.com). This user’s guide provides a description of the features of this software. It
allows end users to assess and test u-blox GPS receivers for navigation and positioning performance.

The purpose of u-center is to enable users to:

Conduct performance tests on u-blox and other GPS receivers.

Configure u-blox GPS receivers.

Access and download Firmware updates.

Test the added performance provided by u-blox’ free AssistNow A-GPS service.

Using this Guide

This guide assumes, the user has basic computer skills and is familiar with the Windows Graphical User Interface
(GUI) and GPS receiver environments.

The following symbols are used to highlight important information:

&~ Anindex finger points out key information pertaining to integration and performance.

& A warning symbol indicates actions that could negatively impact or damage the receiver.

Technical Support

If you have questions about installing or using u-center please:

Read this user’s guide carefully.

Check our homepage (http://www.u-blox.com) to ensure that your GPS receiver, firmware and the u-center
software are the latest versions.

Refer to our web based information service and Database of Frequently Asked Questions (FAQ).
Worldwide Web

Our website (Www.u-blox.com) is a rich pool of information. Product information, technical documents and
helpful FAQ can be accessed 24h a day.
By E-mail

If you have technical problems or cannot find the required information in the provided documents, contact the
nearest of the Technical Support offices by email. Use our service pool email addresses rather than any personal
email address of our staff. This makes sure that your request is processed as soon as possible. You will find the
contact details at the end of the document.

Helpful Information when Contacting Technical Support
When contacting Technical Support please have the following information ready:
Receiver type (e.g. LEA-5A), firmware version (e.g. V5.00), and u-center release (e.g. u-center 5.05)
Receiver configuration
A short description of the application
Your complete contact details

u-center - User’s Guide Contents
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1 Features

u-center evaluation software provides system integrators and end users with a quick and simple way to interface
with u-blox GPS chipsets, modules and boards. It enables easy evaluation, performance testing, development
and debugging of GPS receivers. u-center allows easy connection to u-blox products and provides a suite of
features to view, log, and analyze performance. The features include:

Support for u-blox’ latest receivers using u-blox 5 positioning technology. u-center can communicate with
these receivers using either the UBX protocol, or the NMEA-0183 standard protocol.
Support for receivers that utilize standard NMEA strings.

u-center presents all the information collected during the operation of the GPS receiver. All aspects of GPS
data (position, velocity, time, satellite tracking, etc.) can be monitored and logged under various test
scenarios for the evaluation of a receiver. u-center software allows analysis of the collected data in order to
investigate performance issues such as accuracy, road test position and trajectory, satellite tracking, time to
first fix, etc. All processed data can be captured in ASCIlI format and ported into popular spreadsheets for
creating additional plots and statistics.

Camera View: photographic data can be stored in the log file together with the navigation data and later be
replayed in the application.

Export data files to Google Earth and Google Maps.
Supports AssistNow Online and AssistNow Offline.

Data recording and playback function.

Structural and graphical data visualization in realtime.

Cut and paste export to standard PC application software.

Docking views (real-time cockpit instruments):
Satellite constellation, compass, clock, altimeter, speedometer, GPS and satellite information views.

Download firmware updates into GPS receivers

u-center - User’s Guide Features
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2 Getting Started

2.1 General Information about displayed values

e Longitude and latitude are displayed according to the datum selected in the GPS receiver (usually: WGS-84).
o Time is displayed with reference to UTC

o Elevation is displayed with reference to either MSL (Height above mean sea level or Orthometric Height) or
to HAE (Height above WGS-84-Ellipsoid). The reference is controlled by the GPS configuration.

2.2 Connecting a GPS Receiver to the PC

This section assumes that you have purchased a u-blox 5 Evaluation Kit. Should you try to connect a GPS receiver
to a PC without using the EvalKit, make sure you use appropriate RS-232 level shifters. Connect a serial cable
between a communications port (COM-port) of a PC and the EvalKit.

2.3 Installing u-center
The u-setup installation program guides you through the necessary steps for a successful program installation.

& u-center uses dynamic link libraries (DLL). The installation program will automatically install
the required DLL’s into the u-center program directory. Should you try to copy a u-center
installation from one location to another after the installation, make sure you copy the DLL
files as well.

After a successful installation, u-center will start up as shown in Figure 1:

‘u u-center

File Edit View Player Receiver Tools Window Help
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Figure 1: Start Display

u-center - User's Guide Getting Started
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2.4 Configuring the Serial Connection

u-center stores the serial settings and uses the last configuration when started. When u-center is started for the
first time, the COM port needs to be initialized. This is typically done in the Receiver Tool Bar (Figure 2).

d - U -

h{;\
Figure 2: Receiver Tool Bar

a0 -
Connect/Disconnect-Button with COM-Port selection arrow

Baudrate-Button with baudrate selection arrow

Autobauding-Button

&~ u-center only supports the COM-Settings listed below. All u-blox GPS receivers are pre-configured this
way.
Parity: None
Data Bits: 8
Stop Bits: 1
Flow Control: none

2.4.1 COM-Port

| - A - | ¥ Press the arrow in the Connect/Disconnect-Button and select the used COM-Port

* Dizconnect

COM 1
COM 2
COM 5
COM 5
COM 7
COM &

2.4.2 Baudrate

2.4.2.1 Manual Selection
&~ Does not apply to USB.

J.@. = f””r*|"i |J The baudrate can be manually set or automatically detected by using the autobauding

T feature. Press the arrow in the Baudrate-Button to manually select the baudrate.

2'400
4'500
2800

As soon as u-center is synchronized to the GPS receiver, the Connect/Disconnect-Button on
the Receiver Tool Bar changes the color to green (Figure 3) and the display shows

o information about the satellite constellation, signal to noise ratio, time etc (Figure 5). If the
35400 baudrate of u-center and GPS receiver are not set to the same value, the “Communication
* 57600 Information” icon changes to red. Please refer to section 4 for further information.

115200

J-.-vJ'LI'L[v

ot
ﬁi

Figure 3: COM-Port and Baudrate successfully detected

u-center - User's Guide Getting Started
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2.4.2.2 Autobauding

u-center support autobauding. If frequent break errors are detected, u-center will lower the baudrate, in case of
framing errors, the baudrate is increased until no further errors are detected.

et

TN

Figure 4 Autobauding Button

& Some serial cards or adapters frequently generate errors. The u-center autobauding may not
work reliably in this case. If you experience frequent errors, please set the baudrate manually.

If the GPS receiver is working correctly, the display will show information about the satellite constellation, signal
to noise ratio, time etc (Figure 5)

" r Tooks” Widow el
|oEE-GR[x bes|

R a PO OO -G -&-m- 868
| e[ A w0 @[ [ ——————————— [l B B

Ready = COM3 57600N ntaris L [C=]

Figure 5: Start Display after a successful connection
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3 Concept and Philosophy

Understanding the basic concept behind u-center is important in order to get the highest benefit out of this
powerful GPS evaluation software. Figure 6 depicts the architecture of the software. The program gets a data
stream either from a COM port or a logfile and splits this stream into protocol messages. From the messages,
relevant parameters are extracted and inserted into the current dataset of the database.

In the current dataset statistical values of the parameters are calculated. Average, Minimum, Maximum and
Standard Deviation are calculated for most parameters. If a protocol does not provide a parameter, u-center tries
to calculate the parameter from the ones that are available. For Example if velocity-north and velocity-east are
available, u-center calculates the Speed over Ground and Course over Ground, unless this data is already
available in the protocol.

Calculate
Parameters
from other
Parameters Table Views
Graphical Views
Docking Views
Protocol N
Data Message ) Parameter ﬁ
—> N
Source Parser Extracter Database &, .L
s
.
LogFile.ubx /
Console Views
Calculate Message View
StatiStiCS 12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
—> TiEes
Data Stream 12:00:02 24 47 50 56 54 47
—> Messages >

9 Parameters

24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 00

Figure 6: Engine Architecture

When a new epoch (change in time) is detected, the current dataset is stored as history in the database. This
history has a limited size. If the Size is exceeded u-center keeps only the latest datasets and the oldest ones are
removed. The history size may be adjusted. Refer to section 3.2.5 for the details

u-center provides various view classes for observation. Most of the views take their data from the database. But
there are some views, which get their data directly from the message without using the database at all. The
other views are updated when the database changes.

Message View Displays a copy of every known message. This view allows observing a single message in
detail. It may also be used to send and configure the GPS receiver.

Console Views Display the messages in text form. They are particularly useful for users to develop GPS
firmware code. There is also a wide range of information available, which is useful for evaluation and
testing.

u-center - User's Guide Concept and Philosophy
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Graphical Views Display parameters from the database in graphical form. Charts, Histograms and even a
Map Overlay can be created. There are two more views (Deviation View, Sky View) that may be used for
statistical performance and antenna pattern analysis.

Tabular Views Show the parameters of the database in tabular form. They can be freely configured to
allow customized tables.

Docking Windows Can be docked to the frame of u-center. An analog watch, compass, world map,
altitude and speed meter are available. There are also docking windows showing the current signal power
and the constellation of the satellites received by the GPS receiver as well as a summary of the GPS status.

&~  Displaying various Views and Docking Windows requires lots of computing power. Minimizing or closing
them may significantly reduce the CPU usage.

3.1 Color coding scheme

In the graphical views and some of the docking windows, colors are used to indicate the quality of the data.
Table 1 depicts the color-coding scheme parameters for graphical views depending on the quality of the
navigation solution.

Color Meaning

Yellow Current value

Green 3D navigation solution

Cyan 2D navigation solution
4 Blue Degraded navigation solution (e.g. Dead reckoning)
4 Red No navigation solution

Table 1: Color-coding scheme for graphical views

Table 2 depicts the color-coding scheme for the Docking Windows and Sky View. It indicates the state of each
satellite.

Color Meaning

Green | Satellite used in navigation

Cyan Satellite signal available, available for use in navigation

@ Blue | Satellite signal available, not available for use in navigation

@ Red Satellite signal not available

Table 2: Color-coding scheme for the Docking Windows and Sky View

u-center - User's Guide Concept and Philosophy
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3.2 Operating Modes

u-center has different operating modes. The mode changes when you open or close a log file or when you make
an action in the player. To be able to use the record mode you have to create a new file, save to a new file or
open an existing file. The record and player mode are only available if you have created a new file or when you
have opened a write-able file.

»| Recorder

Open/Create
File

Stop

Online
Mode

Mode
Close/Eject Play/Step/ Scan
File

Figure 7: Relations between operating modes

3.2.1 Online Mode

In this mode a GPS receiver is directly connected to u-center via a serial port with. u-center can control and
configure the receiver, it will display the data that the receiver is sending periodically.

>
Database .- o
N
SRSt

12:00:01 24 47 50 56 54 47|
2C 30 2E 30 30 2C|
54 2C 2C 4D 2C 30|

2E 30 30 30 2C 4E]|
12:00:02 24 47 50 56 54 47|
2C

2C 4B 2C 4E 2A 33|

Figure 8: Dataflow in Online Mode

3.2.2 Stop Mode

In this mode no data from receiver or log file is forwarded to the database and views. u-center is in this mode
when a log file is open but player and recorder are not active.

u-center - User's Guide Concept and Philosophy
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3.2.3 Record Mode

Record Mode is the same mode as the Online Mode. But u-center additionally creates a log file on your disk,
contacting all the messages sent by the receiver. You enter this mode by creating a new log file or opening an
existing log file without write protection and pressing the record button. An example of using this mode would
be to make overnight measurements and evaluate the data at a later time. u-blox customer support may request
a log file from you when you are experiencing a problem with one of our receivers.

@

Figure 9: Dataflow in Record Mode

3.2.4 Player Mode

LogFile.ubx

>
Database

12:00:01 24 47 50 56 54 47
2C 30 2E 30 30 2C
54 2C 2C 4D 2C 30
2E 30 30 30 2C 4E]|

12:00:02 24 47 50 56 54 47
2C 30

2C 4B 2C 4E 2A 33

The Player Mode allows replaying a previously recorded log file step by step, in real-time or at an accelerated
rate. You enter this mode by opening a file and pressing the play, step or scan button.

LogFile.ubx Database

Figure 10: Dataflow in Player Mode

u-center - User’s Guide
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3.2.5 Database Limitation

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of large log files. The
limit is set to 1800 epochs by default. This means if an epoch is available every second you can analyze data for
up to 30 minutes. After this time the oldest values are discarded. Data stored to a log file is not affected by the
database limitation. The number of epochs displayed in u-center can be reset through the menu bar as follows:

File Edit WYew Player Receiver ‘Window  Help

D u D’* . | é &| ‘X’ % F?rmwareUpdateAntaris‘.. ] | = . | . - . - . | - = ||E|.|-|E|-|E|‘E||
Firrnware Update u-blaxs...

SR I | ’.‘-'( A m | | Dump Receiver Diagnastics. .. =3 IH ﬂw uc [E| @
Assisthow Offline. .,
GPS Configuration. ..

Preferences

Generic |Wolkspace| Colors | Meszagebox

Senial ports
W Automatically [disjconnect if most recently uzed serial port [dislappears.

W Enumerate serial ports [this may slow down menus).

M aximum number of zerial ports 255;I

Fower b anagement

& Mone ¢ Deny suspend if connected " Diszornect on suspend

Frogram Options [requires restart]

Database

b a=imurn number of epochs = 00:30:00 at 1Hz rate

(u] 4 I Catcel | Apply |

&~ For long-term observations, it's recommended to start recording a log file before analysis begins.

& If a high value of epochs is selected, the display of data in real-time cannot be guaranteed,
especially when graphical views are open.

3.2.6 Relations between Modes

The operating mode depends on the status of the log file player. Modes are changed by user actions. Each mode
has different states that are changed by a user action or by an event (Figure 7).

In the Online and Record modes, u-center displays data from the receiver. In Player mode data from a log file
is displayed. Player mode has different states. In Play state messages are read and displayed periodically from the
log file. The very intuitive user interface is derived from that of a CD player. u-center updates the views after
each message. Step state only gets one message from the log file and immediately returns to paused Play state.
Scan state also reads messages periodically but the display is only updated when paused or by changing the
state.

Position can be set in a log file. This behaves differently in the Player and Stop modes. In Stop mode the position
is just set and no data is read and displayed. u-center will start recording or playing from that position when
changing the mode. If position is set in Player mode, u-center will load the data up to this position from the log
file and display the contents.

u-center - User's Guide Concept and Philosophy
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4 Menu Structure

4.1 Main Frame

The Main Frame is the primary display screen of u-center. It displays all tool bars and some of the information
provided by the GPS receiver. In the status bar, information about communication, UTC time, Operating Time,
used protocol (NMEA or UBX), used file, etc. is shown.

e Button Function: A description about each button in the tool bars can be obtained by holding the mouse
cursor over the button for a few seconds. A Tool Tip message will appear near the Icon with additional
information while a detailed description is displayed in the Status Display.

Fle Edt Vew Player Receiver Took Window Help Satellite Position

= R %a\shﬁamﬁa\m\@-\v--rm%ﬁ
. G

R|famnje(pr-nk —— ||

mmmE
1

= Cottt S7enon ublox S ol open ko200 (UTE |

e Status Display: display the current action or the function of a button if the mouse cursor is over the button

e u-blox 5 / Antaris Mode: u-center automatically detects the type of GPS receiver connected and activates
the appropriate mode of operation in order to take optimal advantage of the features. The mode can also
be manually selected through the menu bar.

u-center - User’s Guide Menu Structure
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File in use: As soon as a file is used (this file must first be opened) the name of the file will be displayed
(Xxxxxx.ubx)

Protocol Information: This box indicates the current message set that is being used to communicate with
the GPS receiver. This can be the NMEA-0183 standard or the UBX protocol. The UBX protocol provides
more extensive information with the receiver. u-center can handle both protocols.

Operating Time: The time elapsed since you started u-center
UTC Time: The current time sent by the GPS receiver
Communication Information: Shows the active COM port and baudrate.

Color-Coding of this icon: &
Green: data is being received at the correct baudrate
Dark Green: the last data received was valid, but there is no data to collect at this time.
Red: data is being received but errors are detected
Dark Red: no data is being received but errors have been detected in the past
Gray: waiting for first data

|=m= COMS 13200

Figure 11: u-center and GPS receiver are synchronized (green plug)

|<m= COMS 323400

Figure 12: u-center and GPS receiver mismatch (red plug)

4.2 Menu Bar

All u-center functions can be accessed through the Menu Bar, alternatively it may be easier to use the icons in
the tool bars.

u-center - User’s Guide Menu Structure
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4.3 File Menu and Standard Tool Bar

Dz 8R|/ BE e s

Figure 13: Standard Toolbar _

FI=N Edit  View Player Rece N #[: Edit  ‘iew Player Receiver Tools  Window F
P, .. CErl+r M. .. Chrl+r ) | &= J :@
Save ... s —— . Save ... Chrl+5 i
Open... Chrl+0 Open. .. Creo L e
Close &4 Close
Database Empty Database Emphy
Database Export b Database Export Gaogle Map Herl

% ) aoogle Earth Kml
Print. .. Chrl+P Prink. .. CErl+P
Prink Presigw _l— & Prink Preview
Print Setup, .. Prink Setup...
Recent Files 3 Recent Files
Exik Exit

=M Edit Yiew Plaver Receiver Tools ‘Window Help
e, ., Chrl+r P2 | = J :@ :@ :@ | et
Save ... Chrl+5
Open... ko 1 e e |T » | K
Close

Database Empy
Diatabase Export

Print Preview
Print Setup. ..

Printk. .. k4P

1 COMS_ref

T

2 COMS_080611_142620.new
3COMIS_080611_154108
4 COM4_kerlink

Figure 14: File Menu(s) with corresponding toolbar icons

New...

Save...

Open...
Close
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u-center can capture receiver output data into a logfile. However, logging will only start
after Record in the Player Menu has been selected. The elapsed logging time is displayed
in the field operating time. The log files have a ‘ubx' extension.

Opens a new logfile, saves the data from a ring buffer to the logfile and immediately starts
recording all newly received data. This is useful when error or an unexpected event
occurred and no log file was recorded. The size of the ring buffer (4 MB) is large enough
to retain the data for the last hour (approx.).

Opens a stored log file to be replayed.

Closes the log file.

Menu Structure
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Database Empty  All stored values are deleted.

Database Export  Stored u-center logfiles can be converted into HTML or KML data formats for display with
Google Map and Google Earth.

Recent Files A list of the most recent log files.
Exit Terminates u-center.

4.4 Edit Menu

The Edit Menu is fully Windows® compliant.

4.5 View Menu and Views Tool Bar

4.5.1 Text Console

The Text Console displays the content messages in textual form such as UBX-INF or NMEA messages.

E&U Text Console Q@El

§aPZ0A, 120321.00,01, 04, 2008, 00,0064
:03:22  $GPRMC, 120322.00,4,4717.14999, N,00833.95818,E,1.676,332.59,010408, , , A¥67
:03:22  $GPVTG, 332.59,T,,M,1.676,N,3.106,K,A%31
:03:22  $GPGGA,120322.00,4717.14999, N, 00833 . 95818,E,1,07,1.09,423.4,M,48.0,M, ,*52
:03:22  $GPGSA,A,3,20,23,11,17,31,13,04,,,,,,.2.03,1.08,1. 71%00
:03:22  $GPGsv,2,1,08,20,79,030,22,23,62,190,27,11,49,158, 28, 17,349, 260, 25 %78
:03:22  $GPESV, 2,2,08,31, 24,060,23,13, 24, 209, 23,04, 18, 307, 30, 32,08,078, *70
:03:22  $GPGLL,4717.14099,N,00833. 95818, E,120322.00, 4, A%ES
:03:22  $GPZDA, 120322.00,01,04, 2008,00,00%69
:03:23  $GPRMC, 120323.00,4,4717.15089,N,00833.95982,E,1.724, 336.84,010408, , , A¥6F
:03:23  $GPVTE, 336.84,T,,M,1.724,N,3.194, K, A%38
12:03:23  $GPGEA, 120323.00,4717.15089, N,00833. 95982, E,1,07,1.09,421.7,M,48.0,M, , *59
12:03:23 $GPGSA,A,3,20,23,11,17,31,13,04,,,,.,2.03,1.09,1.71%00
12:03:23 $&PGSY,2,1,08,20,79,030,22,23,62,190,27,11,49,158, 28, 17,39, 269, 2578
12:03:23  {GPGsv,2,2,08,31,24,060,23,13, 24, 209, 23,04, 18,307, 30, 32,008,078, *70
12:03:23 $GPGLL,4717.15089,N,00833.95982,E,120323.00, 4, A%6F
12:03:23  $GPZDA, 120323.00,01,04, 2008,00,00%68
12:03:24 $GPRMC, 120324.00,A,4717.15183,N,00833.96159,E,2.109,41.31,010408, , , A*59
12:03:24 $GPYTSE,41.31,T,,M,2.109,N,3. 009, K, A%03
12:03:24  $GPGGEA, 120324.00,4717.15183, N,00833.96159,E,1,07,1.09,419.9,M,48.0,M, , *50
12:03:24 $GPGSA,A,3,20,23,11,17,31,13,04,,,,,,2.03,1.09,1. 71%00
12:03:24 $&PGSY,2,1,08,20,79,030,21,23,62,190,27,11,49,158,29, 17,39, 269, 24*7B
1z:03:24 $GPGSV,2,2,08,31,24,060,23,13,24, 209, 23,04, 18, 307,31, 32,008,078, *71
12:03:24 $GPGLL,4717.15183,N,00833.96159,E,120324.00, 4, A%GE
12:03:24 $GPZDA, 120324.00,01,04, 2008,00,00%6F
12:03:25 $GPRMC, 120325.00,A,4717.15266,N,00833. 96293 ,E,1.734,41.10,010408, , , A%5D
12:03:25 $GPVTE,41.10,T,,M,1.734,N,3. 213, K, A*0B
12:03:25 $GPGGA, 120325.00,4717.15266,N,D00833. 96293 ,E,1,06,1.19,419.2,M,45.0,M, , *54

@ | X |G

Figure 15: Text Console displaying UBX-INF and NMEA messages
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$EPRMC, 120310,
12:03:11  $GPRMC, 120311.00,A,4717. 14048, N, 00833 . 94323 ,E
17:03:12 $GPRMC,120312.00,4,4717. 14066, N,00833. 94352,
12:03:13  $GPRMC,120313.00,A,4717. 14114, N,00833.94379,E
12:03:14  $GPRMC,120314.00,4,4717. 14192, N,00833 . 94454, E
12:03:15 $GPRMC, 120315.00,4,4717. 14280, N,00833 . 94602, E
17:03:16 $GPRMC,120316.00,4,4717. 14373, N,00833. 94761, E
12:03:17  $GPRMC,120317.00,4,4717. 14472, N,00833 . 94898, E
12:03:18 $GPRMC, 120318.00,4,4717. 14578, N, 00833 . 95095, E
17:03:19  $GPRMC,120319.00,4,4717. 14687, N,00833.95303,E,1. 334, 318.40,010408, , , A*6D
12:03:20 $GPRMC,120320.00,4,4717.14796,N,00833. 95480,E,1.509,323.57,010408, , , A*6C

00,8, 4717. ,0
L0
.0
,0
L0
W0
.0
0
.1
!
L]

12:03:21 $GPRMC,120321.00,4,4717.14900, N,00833.95629,E,1.492, 328.00,010408, , , A¥67
1
L
.1
,2
.1
.1
.1
.1
L0
.0
,0
L0

14011, N,00833. 94302, E,0. 608, 297.
.342,293.65,010408, , , A%66
.2FZ,287.43,010408, , , A*6C
.195%,283,39,010408, , , A¥E3
.175, 285, 86,010408, , , A*6E
.555,293, 28,010408, , , A*6E
.7E9,300.36,010408, , ,A%66
.787,306.25,010408, , , A*62

.119,312.45,010408, , ,A%61

72,010408, ,,4%61

12:03:22 $GPRMC,120322.00,A,4717.14999, N,00833. 95818, E,1. 676, 332, 59,010408, , , A®67
12:03:23 $GPRMC,120323.00,A,4717.15089, N,00833.95982,E,1. 724, 336. B4,010408, , , A*&F
12:03:24 $GPRMC,120324.00,4,4717.15183,N,00833.96159,E,2.109,41.31,010408, , ,4%50
12:03:25 $GPRMC,120325.00,R,4717.15266,N,00833. 96293 ,E,1.734,41.10,010408, , , A%5D
12:03:26 $GPRMC,120326.00,A,4717.15358, N,00833. 96438, E,1. 794,40, 80,010408, , ,A%57
12:03:27 $GPRMC,120327.00,A,4717.15397,N,00833. 96504 ,E,1.537,40.43,010408, , , &A%5F
12:03:28 $GPRMC,120328.00,4,4717.15400, N,00833. 96539,E,1.251,40.39,010408, , , 4%50
12:03:29 $GPRMC,1203259.00,R,4717.15373, N,00833. 96519, E,0. 865,40.10,010408, , , ASA
17:03:30 $GPRMC,120330.00,A,4717.15308, N,00833. 96439,E,0. 347, 39.63,010408, , , &%5C
12:03:31 $GPRMC,120331.00,4,4717.15230, N,00833.96332,E,0.088, 36.29,010408, , ,A*5A
12:03:32 $GPRMC,120332.00,8,4717.15097,N,00833.96202,E,0.382,47.03,010408, , , A¥53

& | x (R
Figure 16: Text Console displaying only RMC messages

Element Name Description

& | & Lock Prevents the Text Console from being updated with new data
when locked.

X Clear All Erases all data in the Text Console

Filter On/Off Filter unwanted data from the data stream. This allows searching
for certain expression, e.g. all RMC messages (Figure 16).

Table 3: Description of the buttons of the different Consoles

4.5.1.1 Regular Expression Evaluation

Normally, when you search for a sub-string in a string, the match should be exact. So if we search for a sub-
string "abc" then the string being searched should contain these exact letters in the same sequence for a match
to be found. We can extend this kind of search to a case insensitive search where the sub-string "abc" will find
strings like "Abc", "ABC" etc. That is, the case is ignored but the sequence of the letters should be exactly the
same. Sometimes, a case insensitive search is also not enough. For example, if we want to search for numeric
digit, then we basically end up searching for each digit independently. This is where regular expressions come in
to our help. Regular expressions are text patterns that are used for string matching. Regular expressions are
strings that contain a mix of plain text and special characters to indicate what kind of matching to do. Here's a
very brief tutorial on using regular expressions.

Suppose, we are looking for a numeric digit then the regular expression we would search for is "[0-9]". The
brackets indicate that the character being compared should match any one of the characters enclosed within the
bracket. The dash (-) between 0 and 9 indicates that it is a range from 0 to 9. Therefore, this regular expression
will match any character between 0 and 9, that is, any digit. If we want to search for a special character literally
we must use a backslash before the special character. For example, the single character regular expression "\*"
matches a single asterisk. In the table below the special characters are briefly described. A regular expression
search is case sensitive.

u-center - User’s Guide Menu Structure
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Character Description

A Beginning of the string. The expression "AA" will match an ‘A’ only at the beginning of the
string.
The caret (*) immediately following the left-bracket ([) has a different meaning. It is used to

" exclude the remaining characters within brackets from matching the target string. The
expression "[A0-9]" indicates that the target character should not be a digit.

$ The dollar sign ($) will match the end of the string. The expression "abc$" will match the sub-
string "abc" only if it is at the end of the string.

| The alternation or logic OR character (|) allows either expression on its side to match the target
string. The expression "alb" will match ‘a” as well as ‘b’

. The dot (.) will match any character.

* The asterisk (*) indicates that the character to the left of the asterisk in the expression should
match O or more times.

+ The plus (+) is similar to asterisk but there should be at least one match of the character to the
left of the + sign in the expression.

? The question mark (?) matches the character to its left 0 or 1 times.

O The parenthesis affects the order of pattern evaluation.

[] Brackets ([ and ]) enclosing a set of characters indicates that any of the enclosed characters may

match the target character.

4.5.1.2 Example

Let’s assume that the following lines would appear in the NMEA console without filtering.

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:03 $GPGSV,2,1,07,06,58,062,44,17,52,161,44,25,45,239,44,22,35,301,44*7F
14:00:03 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:03 $GPVTG,80.59,T,,M,0.03,N,0.1,K*56

14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M, ,,,0000*0F

14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2.9,1.3,2.6*3A

14:00:04 $GPGSV,2,1,07,06,58,062,45,17,52,161,44,25,45,239,44,22,35,301,44*7E
14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

In the following examples the characters marked red match the regular expression.

Example 1:

Searching for the RMC with a valid position and all GGA Messages
“GP(GGA|RMC, .*,A,)"

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M,,,,0000*0F
14:00:04 $GPRMC,140004.242,A,4717.1126,N,00833.7862,E,0.02,152.96,010201, ,*0D

Example 2:

Searching for all GSV with the message index of ‘2" or '3’
“GSV, .*,[2-3],"

14:00:03 $GPGSV,2,2,07
14:00:04 $GPGSV,2,2,07,30,31,123,44,10,17,059,39,01,05,316,*4E

,30,31,123,44,10,17,059,39,01,05,316, *4E

u-center - User’s Guide Menu Structure
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Example 3: Searching for all messages starting with $GP, which have a ‘G’ in the message identifier but not

at the first position
"MSBGP . +G_*, "

14:00:03 $GPGGA,140003.242,4717.1126,N,00833.7862,E,1,06,1.3,543.0,M, ,,,0000*09
14:00:03 $GPVTG,80.59,T, ,M,0.03,N,0.1,K*56
14:00:04 $GPGGA,140004.242,4717.1126,N,00833.7862,E,1,06,1.3,542.0,M, ,,,0000*0F
14:00:04 $GPVTG,152.96,T,,M,0.02,N,0.0,K*6B

Example 4: Searching for all message having a checksum of which the higher nibble is 3
“\*3.8$"

14:00:03 $GPGLL,4717.1126,N,00833.7862,E,140003.242,A*34

14:00:03 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

14:00:03 $GPRMC,140003.242,A,4717.1126,N,00833.7862,E,0.03,80.59,010201, ,*36
14:00:04 $GPGLL,4717.1126,N,00833.7862,E,140004.242,A*33

14:00:04 $GPGSA,A,3,06,17,25,22,30,10,,,,,,,2-9,1.3,2.6*3A

4.5.2 Packet Console

The Packet Console lists all incoming messages and provides information about message length and type.

NAV-SWINFO, Size 208, 'Satellite Status and Information’'
NAV-SO0L, Size 60, 'Mawigation Solution’'

NAV-POSECEF, Size 28, 'Position in ECEF Frame'
MAV-POSLLH, 3S1ze 36, 'Geodetic Position'

MAV-DOP, Size 26, 'Dilution of Precision’'

NAV-STATUS, Size 24, 'Nawvigation Status'

NAV-WELECEF, Size 28, 'velocity in ECEF frame'
NAV-WELMED, Size 44, 'Velocity in Was &4'

MAV-TIMEGPS, Size 24, 'GPS System Time'

NAV-TIMEUTC, Size 28, 'Uniwersal Time Coordinated’
NAV-CLOCK, Size 28, 'Clock Status'

NAV-SWINFD, Size 208, 'Satellite Status and Information’
MAV-30L, Size @0, ‘'Mawigation Solution'

MAV-POSECEF, Size 28, 'Position in ECEF Frame'
MAV-POSLLH, Size 36, 'Geodetic Positiaon'

NAV-DOP, Size 26, 'Dilution of Precision'

NAV-STATUS, Size 24, 'Nawigation Status'

MAV-WELECEF, Size 28, 'Velocity in ECEF frame'
MNAV-WELMED, Size 44, ‘'Velocity in WaS 84

NAV-TIMEGPS, Size 24, 'GPS System Time'

NAV-TIMEUTC, Size 28, 'Uniwersal Time Coordinated’
MNAV-CLOCK, Size 28, 'Clock Status'

NAV-SWINFD, 3S1ze 208, 'Satellite Status and Information’
MNAV-S0L, Size 60, 'Nawigation Solution'

NAV-POSECEF, Size 28, 'Position in ECEF Frame'
NAV-POSLLH, Size 36, 'Geodetic Position’
MAV-DOP, Size 26, 'Dilution of Precision’'
NAV-STATUS, 3S1ze 24, 'Mavigation Status'
MAV-WELECEF, Size 28, 'Velocity in ECEF frame'
NAV-WELMED, Size 44, 'velocity in WSS 84
NAV-TIMEGPS, Size 24, 'GPS System Time'
NAV-TIMEUTC, Size 28, 'Uniwversal Time Coordinated’
MNAV-CLOCK, Size 28, 'Clock Status'
NAV-SWINFD, Size 208, 'Satellite Status and Information'
NAV-SO0L, Size 60, 'Mawigation Solution’'
NAV-POSECEF, Size 28, 'Position in ECEF Frame'
MAV-POSLLH, 3S1ze 36, ‘'Geodetic Position'
MNAV-DOP, Size 26, 'Dilution of Precision’'
NAV-STATUS, Size 24, 'Nawvigation Status'
NAV-WELECEF, Size 28, 'velocity in ECEF frame'
NAV-WELMED, Size 44, 'Velocity in Was &4'
NAV-TIMEGPS, Size 24, 'GPS System Time'
NAV-TIMEUTC, Size 28, 'Uniwersal Time Coordinated’
NAV-CLOCK, Size 28, 'Clock Status'
NAV-SYINFD, Size 208, 'Satellite Status and Information’
MAV-30L, Size @0, ‘MNawigation Solution'
MAV-POSECEF, Size 28, 'Position in ECEF Frame'
NAV-POSLLH, Size 36, 'Geodetic Position’
NAV-DOP, Size 26, 'Dilution of Precision’

12 09 NAV-STATUS, Size 24, 'Navigation Status'

12:33:09 UBX MNAV-WELECEF, Size 28, 'Velocity in ECEF frame'

3| X @

Figure 17: Packet Console

Refer to Section 4.5.1 for an explanation of the icons and text fields.
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4.5.3 Binary Console

The Binary Console lists all incoming messages in binary and ASCII format.

00 00 00 OOIppyOOOOOOOOOID
00 43 7B 000000D0OOOOOOIL
ybOOOOADG0
: 47 1b0000BO00000G
12:31:21
12:31:21
12:31:21 18 4b0000AOOO00RD
12:31:21 nboooooooe
12:31:21 pbOOOOADyD
12:31:21 |bOOODADDOODY
12:31:21 pboooooooE
1z:31:21 ubOOOoADRD
12:31:21 ubOO0OAODOOOO™
1z:31:21 ubOOOOOODE
12:31:21 booooo!
12:31:21 ybOO0DADDOOOD,
12:31:21 nbOOOoDDDE
12:31:21 pboooo £
12:31:21 |bO000D0OS
12:31:21 pbogoo*,
12:31:21 00 00 03 03 10 02 50 €3 pbOD{OOOOOOOOOPA
00 00 FA OO FA 00 64 00 O0OD0<0000GO00040
00 0D OO 00 00 00 56 3 ,0000000OOOOOOV:
12:31:21 28 51 phOOOoOO (e
12:31:21 pbooooo]
12:31:21 31 56 pbooooo¥iv
12:31:21 21 pbOOOoDD!
12:31:21 00 02 46 54 pbOOOOD#0OFT
12:31:21 25 4E |bOOO0DOEN
12:31:22 FC OC 84 16 04 00 C1 05  pbO040>00l,D00AD
D3 03 74 4F CC 16 6F 05 DYAHED§0OtOIOOD
FF FF FF FF FF FF 17 00 0O0DOOOR§#§779700
41 40 73 71 00 OOODDA@sq
12:31:22 FC OC CO 74 8C 19 22 24 pbOOO0:0UOALED"S
00 00 48 54 00t0I0o000IT
12:31:22 FC OC EA D3 1B 05 34 46 pbOOO0>0u0E000:F
06 00 54 1A 0D OO &5 2F /OOPOOY.00ZOOO./
noxa
12:31:22 FC OC 48 01 20 01 9E 00 pbO0O0-0GOHD D20
6E A9 0000d000na
12:31:22 FC OC 03 DD 00 00 €4 EC  pbOOO0>0000VOOAT
00IrOo,:
12:31:22 FC OC GO 00 00 00 FE FF  pbO0O00>0u00000RF
00 0D 4E 7B FP9yyyO00ON]
12:31:22 FC OC FF FF FF FF FE FF  pbOOSO-0ulfyyyhy
00 0D Oz 00 0D 0O 40 9F  FyOOOOOOOOOOOOEY
OF 02 F1 5D §00000, E0OAD
1z:31:22 FC OC &84 16 04 00 C1 05 b0 O0>000,000AD
00000010
1z:31:22 FC OC 14 00 00D OO0 05 52 ybO!00>00000000°
24 03 18 DD &F@00000§000
B % @]

Figure 18: Binary Console

Refer to section 4.5.1 for an explanation of the icons and text fields.
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4.5.4 Message View

The Message View is utilized to communicate with the GPS receiver. Receiver output messages (e.g. navigation
output, status and debug information) are displayed; input messages (e.g. configuration messages) can be sent.
There are different sections for NMEA and UBX protocol.

3 Messages - NMEA - GPGGA (Global Positioning System Fix Data)
W
'GPDTM (Datum Reference)

) NMEA - GPGGA (Global Postioring System Fix Data]
GPGBS (653 Satelite Fault Detection)

= ] Parameter I Value| Unit| Descripion
GPGLL (Geographic Poston - Lattudeflongtude) | [yrc 1232000 hmsssss Uriversaltie coordinated
GPGRS (G155 Range Residuok

Lat ATIT.09774  ddmamnmn  Latiude
Noithing Indicator NeNorh, 5:

69G5A (@155 DOP and Active Sstslites) N .
GRGST (IS5 Pseudsrane Ever Sttt Lon 0083394608 cddmmanmm - Longiude
GPas (Gs3 sakelites i iew) Eastingndicaon € E-ast Webest
(((( || totus 1 Oeinveld, 1+20/30, 24DGPS, GeDead Reckoring
o R W v 1 et of SV e ot Navigaton
P 085 Horzoral Didin o Pecison
P ALMSL) 5017 - Abiude (above reans sealevel)
G92DA (T .Dste) Unt M Mebletrs
PuEx GeoidSep. 3 ' Geoid Separaion = ARHAE) - ARMSL)
e ke Unit M
o hge of DGPS Can s
e DEPS R Staion
Untiown

cusTom

0000 24 47 S0 47 47 41 2C 31 32 33 32 34 30 2E 30 30 2C 34 §GPGGA,123240.00,4
001z 37 31 37 2E 30 39 37 37 34 2C 4E 2C 30 30 38 33 33 2E 717.09774,N,00833.
0024 39 34 36 30 38 2C 45 2C 31 2C 31 31 2C 30 2E 38 35 2C 04608,E,1,11,0.85,
0036 35 30 31 2E 37 2C 4D 2C 34 37 2E 33 2C 4D 2C 2C 24 35 SOL.7,IL47.3,H,, 75
ooss 37 0D o4 7m0

1 O I
_ & | | B oo (X &

Figure 19: Message View

Element Name Description

3 | [-E] Lock Prevents the Message View from being updated with new data
when locked.

o4 Clear All Erases the entire Message View.

= Send Sends the current message to the GPS receiver.

e Poll Polls the selected message once.

g Auto poll Automatically polls a newly selected message once

BE] Message Hotkey Assigns a hotkey to the selected message

Table 4: Description of the buttons in the Message View
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4.5.4.1 Receiver Output Messages

P Messages - UBX - NAV. (Navigation) - POSECEF (Position ECEF)

UBX - MAW [N avigation] - POSECEF (Pasition ECEF) ~
ACK (Acknowledge) N
AID (6P Aiding) Tine cfvesk | 220272000 [5]
< (confio)
ECEF-X 428647183 [m]
ECEF-Y 645646.86 ]
. e
CLOCK (Clack Skatus) ECEF-Z AGEIT2B61  [m]
DGP5 (DGPS Dat) e e
DOP (Dilution of Precision)
- EKFSTATUS (Status) (ResTienED 8 ()
POSECEF (Postion ECER)
POSLLH (Geodetic Position)
POSUTHM (Position UTM Grid)
SBAS (SBAS Status)
50L (Navigation Solutior)
STATLIS {Navigation Stakus)
SVINFO (SV Infarmation)
TIMEGPS (GPS Tirhe)
TIMEUTC (UTC Time)
- MELECEF (¥elocity ECEF)
WELNED (Welocity WGESE4)
RXM (Receiver Manager)
TIM (Timing)
oo R TR TR T T ub;mwn{gmmé_
0012 2F 49 CC 1B 44 03 00 00 C2 BE /110J0004%
asoun
cusrem

& | % [ Eees ool [ &8

Figure 20: Message Display of an output message

&~  Double-clicking on an output message enables or disables the periodic message update if the
communication protocol is active. This feature is currently only supported for the UBX protocol.

4.5.4.2 Receiver Input Messages

Input messages can be edited and sent to the GPS receiver from the Message View. It is also possible to poll the
current receiver settings.

= — A=

B HMEA, |
= UBX
- ACK (Acknowledge)

B 810 (GPS Aiding) Target |3 -1USE vl

B CFG (Canfig)

- BT (Antenna 5 Protacal in |D+1 - LIEX+MMEA -I
eraenfioust | protocel out [0+1 - UBX+HMER -]

- DAT (Dakum)
- EKF (EKF Setting oy
s FM (Fis Mo M2

- IMF {InflMessage

- LIC (License)

- 150G (Messagesi—
- MAY (Mavigation |

- IAWE (Mavigatio
IAYS (Mavigatio oooo BS 62 06 00 14 OO0 03 00 wbi0O0000

_AMEA WER Py | 0008 00 0D 00 00 00 00 00 00 OO000000
FRT Forts) 00L0 0O 0D 03 00 03 00 00 00 OO000OOO

.-RATE {Rates) 0018 00 00 23 AE OO#@
- ST (Reset) \
- R (Receiver

- SEAS (SEAS Sett B8]
< i >

@ | X | Boend vl [ | o

UBX - CFG (Config] - FRT [Ports] 4022

\l/

Figure 21: Message Display of an input message

&~ u-center performs some range checks on input messages. If an input value exceeds the permitted range,
u-center will highlight the field in red but it is still possible to send the value to the receiver. However,
the receiver is likely to reject such a message.
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4.5.5 Statistic View

All available GPS values (transmitted from the GPS receiver or calculated by u-center) are displayed. The
following statistics are displayed:

e Current Value
e Minimum Value
o Maximum Value

e Average Value
Standard Deviation

3! statistic View

Tikle | Counk Age | Current Mairnurn Awverage | Dierviation | Unit | Descripkion

uTC 3778 0 13:34:09.001.. 13:34:09.001... time date  Time UTC

GPS time 3778 0 1473221663, d 14731221663, wnaikow  Time GPS

TTAG 3779 1} 221663001 217554.995 221663.001 s TTAG (from ITOW)

TaCC s 1 [ 0.012000 0.069000 0.019155 0.006005 us  Time Accuracy

TimeSkarkup 377G a 4451.615 674,629 4451.615 2563115 1090.617 5 Time since Startup

TTFF 1 s rrr 1 60,612 60,612 60,612 0,000 s Time ko first Fix

Lak 3775 a 47.285180 47.284915 47 286672 47.255185 0.000177 @ Position LTP Latitude

Lon 3778 1} 8.565771 8.565298 8.566504 8.565715 0.000095 ¢ Position LTP Longitude

Ak (HAE) 3775 1} 563,78 355,44 602,46 563,39 25.75 m  Position LTP Alitude (ab...

Alt {M5L) 377G a 515,79 340,44 554.46 515.40 25.75 m  Position LTP Altitude {ab...

kS 377G a 4256476,.56 4286236,53 4256500.32 4256476.24 28.25 m  Position ECEF X

¥ 3775 a 645649.52 645595,11 6456580.52 645645, 16 7.56 m  Position ECEF ¥

Z 377G a 466374363 4663699, 55 466575741 4663743.99 15.69 m  Position ECEF 2

P&CC 30 3778 1} 7.140 6.850 37.320 9.774 2.544 m  Position Accuracy 30

PACCH 3775 1} 4.521 4,247 30,922 6,090 1.704 m  Horizontal Position Accu...

P&CCY 377G o 5.530 5.326 21,962 7.596 2,077 m  Vertical Position Accuracy

WK 377G a 0.o0 -0.22 1.09 0,01 0.06 mys  Welocity ECEF ¥

W 377G a 0.o0 -1.25 2.62 -0.00 0.07 mys  Welocity ECEF ¥

WE 3775 a -0.01 -1.29 0.65 0.0z 0.13 mfs  WVelocity ECEF Z

WM 3778 1} 0.00 -1.90 0.32 0.01 0.10 mfs  Yelocity LTP Morth

VE 3775 1} 0.00 -1.39 244 -0.00 0.05 mfs  Welocity LTP East vy
——

Figure 22: Statistic View

&~  Choosing Database Empty in the File Menu or pressing the Button & deletes the Statistic View.
&~ The content of the Statistic View can easily be exported to other programs using Copy/Paste.

4.5.6 Table View

All values from the database can be displayed in a tabular form (Figure 23). This is very useful when analysing
logfile in detail.

Table - [Index / UTC / Lat / Lon / Alt (HAE) / PDOP / Used SVs] M=1E3
uTcC Lak Lon Alk (HAE) FDOP Used Sis 2
14:01:07... 47.285012 §.565717 554.45 3.5 24,152,
14:01:08... 47.285010 §.565717 554.40 3.5 Z2,4,15,2...
14:01:09... 47.285009 8.565717 E54.35 3.5 2,4,13,2...
14:01:10.., 47285003 8.505716 554,30 35 2,4,13,2..
14:01:11... 47.285007 §.565716 554.23 3.5 24,152,
14:01:12... 47285007 §.565715 554.15 3.5 Z2,4,15,2...
14:01:13... 47.285007 8.565713 C54.17 3.5 2,4,13,2...
14:01:14.., 47, 285005 8.505712 o417 35 2,4,13,2..
14:01:15.., 47285006 §.565711 554.16 3.5 24,152
14:01:16... 47. 285006 §.565710 554.13 3.5 Z2,4,15,2...
14:01:17... 47. 285006 §.565710 554.13 3.5 24,132,
14:01:18.., 47, 285005 8.565709 o412 35 24,132, —
< LI
= = |UsedSvs -

Figure 23: Table View
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To add a new column, first select the desired value (Figure 24) and click the + Button. To remove a displayed
value, click the — Button. To see the Table header click the =] Button.

¥ Table - [Index / UTC / Lat / Lon / Alt (HAE) / PDOP / Used SVs] =13

Index uTC Lat Lon Alt (HAE) FDOF Used Sis | A
4514 14:04:44,., 47, 255006 5.565746 548.02 2,4,13,2...
4515 14:04:45,., 47.285009 8.565744 548.70 2,4,13,2...
45316 14:04:46,., 47285012 5565742 549,23 24,132,
4517 14:04:47... 47, 285015 5.965739 549.89 24,13,2...
4516 14:04:45... 47. 285017 5.965737 550.41 Z2,4,13,2...
4519 14:04:49,., 47.2585018 5.565736 550,77 2,4,13,2...
4520 14:04:50... 47.285018 8.565734 551.11 2,4,13,2...
4521 14:04:51.., 47285020 5565733 551,52 24,132,
4522 14:04:52. .. 47, 289021 5.9657352 551.83 Z24,13,2..,
4523 14:04:535... 47, 285022 5.965732 552.09 Z2,4,13,2...
4524 14:04:54... 47285021 5.5965732 552,14 2,4,13,2...
4525 14:04:55... 47285020 8.565732 552.08 2,4,13,2...

i)
8 + SW2Mode v

SW2 Mode
SW2 Used
SW2EI
V2 Az -
G2 CND

5V2Ch

52 Doppler

SW2 Residual

52 Range

SW2 Carrier

SW3Mode

543 Used

SVIEI

543 Az

>

SW3Ch

543 Doppler

5%3 Residual

SW3 Range

53 Carrier

SV Mode

544 Uszed v

Figure 24: Selecting a new value

&~ The number of displayed epochs is set to 1800 by default (see also section 3.2.5 Database Limitation).

&~  Choosing Database Empty in the File Menu or pressing the Button & deletes the Table View.
&~ The content of the Statistic View can easily be exported to other programs using Copy/Paste.

With the function Recent Table View one of the last 8 used tables can be selected (Figure 25) and displayed.

Table Wiew i1
it Tab 1 lndex / TDOF / Tracked Ss

2Index / TDOP / SW2 Ch
3Index /WDOP
4 |ndex / VD
&Index / SWV1E El
B Index / Colz
7 lndex /UTC
8 Index / 5432 C/NO

Figure 25: Recently used tables

4.5.7 Chart View

Chart View allows the user to conveniently view GPS-Data records in graphical form. The data can be scaled in
many different ways and formats. It's even possible to print the entire chart.
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The examples below illustrate 3 different typical applications

8 Chart - [Alt (HAE) / Index]

o B E - Tyl armeE BT | Ad

< - >
B RKE-I Y f e % [alHAE] ~| | A

Figure 27: Index as a function of Altitude (X = Altitude, Y = Index)

B Chart - [Lat / Lon]

£

>
e d &R - I F v | |+ R Lo - || A

Figure 28: Latitude as a function of Longitude (X =Longitude, Y = Latitude)
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Element Name Description

s Cursor The cursor position is shown in the lower left edge of the u-
center windows. Click the right button mouse and hold the
button down to measure differences.

Move The chart is moved inside the Chart View Window. Click and

Drag/Drop the Chart.

& Zoom In Drawing a rectangle enlarges the chart to the new view. To zoom
in the Chart 2x click on the chart

IE Zoom Out Drawing a rectangle decreases the chart to the new view. To
zoom out the Chart 2x click on the chart

. Drawing Mode The size and form of the displayed values can be changed in the

menu points; the connection line between the values can be
selected in the menu Connect. For viewing the statically values
(average, minimum, maximum, standard deviation) directly in the
chart select the Statistics Menu

FitY

Fit the Y Range

Follow Y

Follow the most current Y-Value (the most current Y-value is
always in the middle of the chart)

Index or Y Value

Switch between the Index and the Y Value

|Lat j Y Value Select the Y Value to be displayed
lﬁ Fit X Fit the X Range
Follow X Follow the most current X-Value (the most current X-Value is

always in the middle of the chart)

Index or X Value

Switch between the Index and the X Value

I Lon j

X Value

Select the X Value to be displayed

L I‘IE.III vI

Moving Average

Adds a moving average. The average is calculated over the
number of most recent values, specified with the parameter.

Table 5: Description of the buttons and displays in Chart View

&~ The number of displayed epochs is set to 1800 by default (see also section 3.2.5).
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4.5.8 Histogram View

Histogram Views allow the user to view GPS-Data and probability distributions (Figure 29) and print the entire
histogram if desired. The number of bins (storage containers) can be set by the user.

BB Histogram - [Alt (HAE) with 64 bins]

o RO - L | T e fanmae ~| [s4 +
Figure 29: Altitude Histogram View

E® Histogram - [Alt (HAE) with 64 bins]

450,00

= N N R e e Y e A T |

Figure 30: Probability Chart

&~ The number of displayed epochs is set to 1800 by default (see also section 3.2.5).
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Element Name Description

s Cursor The cursor position is shown in the lower left edge of the u-
center windows. Click the right button mouse and hold the
button down to measure differences.

Move The Histogram is moved inside the Histogram View Window.

Click and Drag/Drop the Histogram.

& Zoom In Drawing a rectangle enlarges the Histogram to the new view. To
zoom in the Histogram 2x click on the Histogram

IE Zoom Out Drawing a rectangle decreases the Histogram to the new view.
To zoom out the Histogram 2x click on the Histogram

. Drawing Mode The size and form of the displayed values can be changed in the

menu Points. The connection line between the values can be
selected in the menu Connect. For viewing the statically values
(average, minimum, maximum, standard deviation) directly in the
Histogram select the Statistics Menu

Probability

Display the probability Histogram (Figure 30)

Fit Probability

Fit the Probability Range

IE Fit X Fit the X Range
I’*‘“ HAE] j Y Value Select the Y Value to be displayed
Bins The number of Bins

T

Table 6: Description of the buttons and displays in Histogram View
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4.5.9 Camera View

The Camera View function enables photographs, taken during recording of log files, to be linked to the GPS
data stored in the corresponding log files. This allows a video depiction of the test, with a picture assigned to a
specific point of GPS data.

‘u u-center,

File Edt Yew Player Receiver Took Window Help

D@ &0 =08
Jam[e[p[rn|w[—F———— 3|1 1| &
[ oo g |a@een =0 @ & -Mm-

E¥ Cam Window

Goko Poskion 2113411613 | 34563526 @ comt 00N wboxs gl EVRSH_4.0_goadint Poriior [fsrn [&

&~  Using Camera View can result in very large logfiles and can slow down u-center when playing such files.
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4.5.10 Deviation Map

The Deviation Map displays positions in longitude and latitude relative to a defined reference position.

L2 Deviation Map

159, EITI

o5 | [ <[

Figure 31: Deviation Map

Element Name Description
Properties The Reference Position can be defined as:

The average of all previously measured positions
The current position
A fixed, predefined value

The radius of the outer circle can be adjusted with the Max.
Deviation parameter.

E., Fit Automatically adjusts the Reference Position and the Max.
Deviation to fit all positions into the Deviation Map.
Track
T+ Statistics

Table 7: Description of the buttons and displays in Deviation Map

&~ The number of displayed epochs is set to 1800 by default (Section 3.2.5).
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4.5.11 Map View

u-center can display positions on pre-calibrated maps (Figure 32). This allows a basic analysis of road tests.

@] Map - [office-free.jpg]

P u-blox AG, Zurcherstrasse 68, CH-8800 Thalwil, Switzedand  http:/Awwav. u-blox.com =
<

b R A [T <] [ - Bk A S @ BT

>

Figure 32: Displaying a position

4.5.11.1 Using Map View
You can access the view specific commands in two different ways:

Using the command in the Tool Bar below the Map View.
Holding the cursor inside the Map View and pressing the right mouse button will. This will open a context

menu:
Zoom Factor Adjust Colors
kR[S @ A S
Curszor
* Move
Zoom Jn
Zoom Quk
Fit Map
Markers
Follaw
* Mane
Dat Cannect > OpenMap.. |
Bold Dop Statistics Becent Maps 3 |
Save Map View...
Cross -
Bold Crozs LCopy
u-center - User’s Guide Menu Structure
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Element Name Description

s Cursor The position of the cursor is shown on the lower left edge of the
u-center screen (Longitude, Latitude and Pixel-Position). By
holding the left mouse button and moving the cursor over the
map you can measure distance from one position to another

& Move The map inside the Map View Window can be moved

& Zoom In The map is enlarged by selecting a rectangle

Zoom Out The size of the Map is decreased

Zoom Factor

Different specific zoom level can be selected

Drawing Mode

The size and form of the displayed position can be changed; the
connection line between the points can be selected in the menu
Connect. To see statically values (average, minimum, maximum,
standard deviation) directly in the map, select the Menu Statistic.

W Fit Map The map size is adjusted to fit the Map Window

X Follow Center the map on the current GPS position

k. Markers Add or remove the defined markers (see also 4.5.71.3 Map
Calibration)

B . Open Map Load a new or one of 8 recently used maps.

= Save Map View The current display can be stored in different formats

o Adjust Colors Brightness, contrast and color saturation of map can be adjusted

by moving the glides

Table 8: Description of the buttons and displays in Map View

&~ Map Views can be copied to the clipboard using the ‘Print Screen’ function.

&~  Choosing Database Empty in the File Menu or pressing the Button & deletes all recently displayed
positions and routes.
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4.5.11.2 Application example: Reviewing a road test
e Open a u-center logfile (refer to Section 4.3).

« In the Player Menu or player Tool Bar | = ® [ ® ¥ -» [k 4 | select the menu Play or
click the button '~ Deactivate in the Player Menu Pause or click the button

¢ Now, the stored positions are displayed (Figure 33).

[ Map - [officemapoverlay.bmp]

<
b ®A i L@ bk b F-BE W

Figure 33: Logfile from a road test

4.5.11.3 Map Calibration

To create your own map you will need a digitized map or pictures with orthogonal projection in one of the
following pixel graphics formats.

e png Portable Network Graphics,
e bmp Windows Bitmap

o dib Device Independent Bitmap
o gif Graphics Interchange Format
* jpg/jpeg Jpeg File Interchange Format
o pcx PC paintbrush

o tif Tag Image File Format

If your map is not in one of the above formats, you can simply convert it in one of the supported formats by a
third party program. u-blox provides two sample maps. Office.png is a small map of the surroundings of the u-
blox headquarters. World.png is a map of the whole world but with limited resolution.

To use a map in u-center, three calibration points are needed. For these points you have to know the pixel
coordinates and the according WGS84 coordinates in the latitude/longitude format in degrees (longitude: -180.0
to 180.0, latitude: -90.0 to 90.0). These points are stored in the map calibration file. The calibration file must be
stored at the same location as the bitmap itself. It has the same name but a different extension (*.mcf). The
Format of the calibration file is very simple and can be edited in a simple editor like notepad.
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Examples:

As an example we will have a closer look at the provided map ‘world.png"' and its calibration file 'world.mcf'.

Y/X

v
Digital Map File: world.png

The Map has 1765 Pixels (0 to 1764) in the horizontal and 1046 Pixels (0 to 1045) in the vertical direction. The
origin is the upper left corner. To calibrate this map we will use the following three calibration points (#1 to #3).

Pixel WGS84 Coordinate
Reference Point # | X Y Longitude | Latitude
Upper Left Corner 110 0 -180.0 90.0
Lower Right Corner 2 [ 1764 | 1045 | 180.0 -90.0
Upper Right Corner 311764 |0 180.0 90.0

To determine the exact pixel position you can use Microsoft Paint (mspaint.exe) or any other pixel-editing
program.

The calibration file is a plain ASCII text file. The file may contain comments. The file consists of two sections,
which start with keywords encapsulated in braces.

The REFERENCE section, which is mandatory, contains the three points used to calibrate a map. Each reference
point is on a single line and has the following syntax:

“# = <x>, <y>, <lon>, <lat>”

where # is the index of the reference point <x> is the horizontal and <y> is the vertical image coordinate and
<lat> is the Latitude and <lon> is the Longitude in degrees and WGS84.

The MARKER section, which is optional, defines additional points on the map. Each point is on a single line with
the syntax:

“# =01, <x>, <y>[, <text>]” or “# = c, <lat>, <lon>[, <text>]”

where # is the index of the marker point <x> is the horizontal and <y> is the vertical image coordinate or <lat>
is the Latitude and <lon> is the Longitude in degrees and WGS84. <text> is a optional string in quotes labeling
the marker point. The points must have a unique index from 1 to <num>. The maximum marker point index
<num> is written to the same section on a separate line with the syntax “Count = <num>".
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; File: world.mcf
; Source: (sample data set)

REFERENCE

3 Points must be defined to calibrate a Map

Parameters:
# = index of the point (1 to 3)

; X,y = image coordinates
; lat,lon = world coordinates
; Syntax:
= # = <x>, <y>, <lon>, <lat>
[REFERENCE]
1= 0, 0, -180.0, 90.0
2 = 1764, 1045, 180.0, -90.0
3 = 1764, o, 180.0, 90.0

MARKER

; You can add points (image or world coord) to the map
; Parameters:

; num = number of markers that follow

; # = index of the point (1 to num)

; type = c for world or i image coordinates

; X,y = image coordinates

; lat,lon = world coordinates

; text = quoted text decription to the marker (optional)
; Syntax:

; Count = <num>
= # = <type>, <x|lon>, <y|lat>[, <text>]

[MARKER]
Count = 1
1 = c, 8.56525, 47.28519444, "u-blox ag"

Map Calibration File: world.mcf
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4.5.11.4 Map Calibration Tool

u-center includes a built-in calibration tool for providing coordinates to maps and photographs in supported data
formats to create u-center maps. To use the tool open the Map View window as seen in Figure 34 and then as
seen in Figure 35 open the file of the map to be calibrated (in our example GoogleScreenShot.bmp).

File Edit Flayer Receiver Tools Window Help
ODE Packet Console F& A m
2 Binary Console F7 2

fap= - Text Conscle F& > - M

Messages View Fa
Configuration View Chrl+F2

Statistic View F10
Table Yiew Fi1
Recent Table Views

Recent Map Views
Chart View

Recent Chart Yiews
Histogram View
Recent Histagrarn View
Camera View

Deviation Map
Sky View

Docking Windows
Toolbars

Figure 34: Opening Map View Window

Look in: IE} u-center j = £k B
= EWUrId.png
'.J @u-blox demo.png
Recent S co0 .

|C5) Documentation

My Documents

My Computer

by Metwork, File name: IGoogIeScreenShot.bmp j Open I
Flaces
Files of type: IMap Files [".png;".ipg;".ipeg;".gif;".tif;".pcx;".bm|L| Cancel |

&

Figure 35: Opening the file of the map to be calibrated

If the file to be opened has not been calibrated, the following message will appear:

There iz ho calibration file for this map. Please press Yes to start the calibration process:
\V first click on a known position inzide the map, then enter the coordinates into the dialog box.
Attention; pozition click plus coordinates entering has to be repeated three times!
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Select three points on the map and enter the calibration coordinates in the specified format as seen in Figure 36,
Figure 37 and Figure 38.

ap - [GoogleScreenShot.bmp]

)

Coordinate Systern

‘“‘*‘%‘ IWESE4 Lat/Lon in Degres, Minutes and Seconds ;l Cancel
‘ Lon® |8 Lon' |33 Lon' |48.08

Lat' |17 Lat* |11.99
3 ')\" L L

Coordinate System
il |\W/GSB4 Lat/Lon in Degres, Minutes and Seconds x| cancal

Lon® |8 Lo’ |34.5 Lon™ |32
W e[ weEd

i |2 ]

£
bR R - b A S-HB W

Figure 37: Calibrating a Map Using Calibration Tool (position 2)
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Coordinate System

M| [wG584 Lat/Lon in Dearee, Minutes and Seconds ~|  Concel

Lon® |8 Lan' |33 Lon" [58.17
Lat® |47 Lat' [17 Lat" 255

Figure 38: Calibrating a Map Using Calibration Tool (position 3)

Following these steps the map is now calibrated and can be used with u-center for visualizing road tests etc.
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4.5.12 Sky View

Sky View is an excellent tool for analyzing the performance of antennas as well as the conditions of the satellite
observation environment. The polar plot graphically displays the averaged relative satellite signal strength (Figure
39), the position of satellites in the sky, identifies satellites by number and indicates which satellites are being
used in the receiver calculation (see Section 3.1). Right-clicking the mouse on Sky View allows the copying of
C/No values in tabular form to another program.

& D ke §

Figure 39: Sky View

Element Name Description

Linear Selects a linear projection of the Sky View
Sine Selects a sinusoidal Projection of the Sky View
& C/No Displays the averaged C/No values

(=) Orbits Displays the orbits of the satellites

¥ SVs Displays the current position of the satellites
wEE Coord. Adds a caption for the azimuth

i Elevation Adds a caption for the elevation

Table 9: Description of the toolbar in Sky View
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4.6 Receiver Menu and Receiver Toolbar

File Edit Wiew Plaver Tools  WWind
& = -
IR B
Baudrate — nu -
Aukabauding L
J Al v T | e J ) u-hlax 5 Mode

Ackion

Figure 40: Receiver Menu with corresponding icons from Receiver Toolbar

In order to communicate with a GPS receiver, u-center must have the correct COM port settings. Please refer to
Section 2.4 for a description of the settings.

&~ Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list.
If a COM Port is grayed out, another application on the computer is using it.

4.7 Action Toolbar and Menu

File Edit “iew Flaver Tools  indow  Help
[
DEH=- &R ™
Baudrate k

J : Autobauding FE-» | Ly -I
+"+';l u-blox & Mode | :\icﬁl hig_?l hig_bl | |

Coldstart
Warmstart
Hakstart
Assisthlow Online

| B v o f=

The Action toolbar and menu are used to command the receiver to perform a Cold-, Warm- or Hotstarts, or to
implement the AssistNow Online Aiding (A-GPS) function. More information about AssistNow Online is available
from our website at: http://Awww.u-blox.com/services/assistnow_online.html. In order to take advantage of
AssistNow Online, customers must register with u-blox. Please contact your nearest u-blox sales office to get
access details.
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4.8 AssistNow Offline Toolbar and Menu

|| SREEEEEaaasaEanE 24 || SEEEEaaaaaaamanE

File Edit Wiew Plaver BN Window Help

Firrmware pdate Ankaris ...
Firmware pdate u-bloxs, ..
Durnp Receiver Diagnostics. ..

FFline. ..
GPS Configuration. ..

Hotkeys ..
Preferences. ..

The AssistNow Offline Toolbar and menu is used to download AlmanacPlus aiding data for A-GPS. AlmanacPlus
data files are available in various sizes to provide aiding for periods of 1 to 14 days. More information about
AssistNow Offline is available from our website at: http://www.u-blox.com/services/assistnow_offline.html.

4.9 Player Menu and Player Toolbar

2am oD -» K I _e

Eject CtH+E =
v Skop Ckrl+H [}
Pause Chrl+P
Record Chrl+R — %
Skep Ctrl+Space ——— [ Slaw
p|a.:',. Chel+G [ETTTTTTTTTLT PP TTT PP PP rrY ﬂljfl'l'lEl' | h w2
Scan Chrl+F — M Fast
aato Begin -
Goko End —=H

Goto Position 3

The primary function of the Player is to display previously recorded GPS data from a file. Refer to Section4.3 for a
description on how to create or open a log file. Using the player controls, you can step through or play all
messages from the log file. The series of buttons in the player toolbar can be used to navigate through the log
file. The records will be displayed on the navigation display window, in the same way that live GPS data is
displayed when using u-center. The current file that is being displayed is shown in the box “File in use”.
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Element Name Description
Y Eject Close the active log file
| Stop Stops displaying or recording to the active log file
Pause Pauses displaying or recording to a log file
) Record Starts recording to the previously created logdfile. Please note this function is only
available if a logfile has been opened before.
I Step Single step function, the next message is read
- Play Starts to display a log file. You can select the speed of the action. After each

message the display is updated as required

19 Scan Reads the entire log file into the database and updates the display at the end of
the scan period
M- Go to Begin Set the read path to the begin of the log file
= Go to End Go to the end of the log file
[ Go to Position This slider bar is used to shuttle back and forth through the history log. Pulling

the slider to the right will fast-forward the playback, and pulling it to the left will
rewind the playback

Table 10: Description of the buttons and the slider in the Player Toolbar

4.10View Menu: Docking Windows

The Docking Windows are graphic displays, which provide real-time information about the GPS receiver. These
are the most commonly used windows for u-center users. Eight different panes can be displayed: receiver status,
satellite and signal strength information, position on a world map and 4 analog dials. The windows can be
resized, closed or moved anywhere on the screen. Refer to Section 3.1 for an explanation about the color codes.

To open these windows, select Docking Windows from the View menu, or simply click on the icons on the
View tool bar.

v Satellite Paosition
v Satellite Level

v \world Position
v Daka

v Altitude Meker
v Compass
v Speed Meter

v Watch —I_
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Satellite Level

Displays Elevation,
Azimuth and C/NO
(dBHz) for SVs

Satellite Position
Displays the position
of satellites in the
sky

World Position
Displays the current
Position on a world
map Speed Meter
Displays the current
speed

Compass

Displays the current
course over ground

Altitude Meter

Displays the current
altitude

Receiver Status

Displays a summary

of the receiver

status. 00

= Watch

| Displays the date

||||||||||' 1 and the current
| UTC-Time

Figure 41: Docking Windows

4.11Tools Menu

4.11.1 Firmware Update (u-blox 5)
The receiver firmware can be updated with the firmware update function in the Tools Menu.

Establish the serial communication between u-center and the GPS receiver (see also section 2.4).
Start the Firmware update tool under u-center menu "Tools" and then "Firmware update u-blox 5”.
Select the path of the Firmware image and Flash definition file (see Figure 42)

Select the update mode "ROM3 over USB" if you're using the USB port or "Enter Safeboot before update”
with USART.

Select the download baudrate. etc.
Select "Erase whole Flash" only if you want to delete all stored configuration and factory settings.

u-blox5 Flash Firmware Update _&

Firtnware image

IC:'\ubIDxE\Firmware'\ubloxE_FW_E.DD_LEA—EH_With_ROMS.bin LI |
Flash definition file
IC:\ubonE‘-,u—center'\flash.b:t LI |
[v Use this Baudrate for update v ROM3 over USE (no Hub)

|1 16200 LI [T EnterSafehootbefore update

¥ Clear BER: befare ipdate

[v Erasewhaole Flash 0K | Cancel

Figure 42: u-blox 5 Firmware update window
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4.11.2 Firmware Update (ANTARIS 4)

The

receiver firmware can be updated with the firmware update function in the Tools Menu.

Establish the serial communication between u-center and the GPS receiver (see also section 2.4).
Start the Firmware Update Tool
Select the path of the ‘prodstub’ (ATR0620l.exe) and the firmware image.

Select the ‘Production Mode’. ANTARIS® based GPS receivers can be put into boot mode by sending a UBX
protocol command. If the GPS receiver connected to u-center is configured for UBX protocol input, choose
the ‘use serial port’ option. Otherwise, select ‘use bootmode pin’ and put the receiver manually into boot
mode.

Check the COM port (u-center automatically initializes the COM port with the u-center COM port).

Select the download baudrate. This is the baudrate used during the firmware download. The default value is
115200 baud. The lower this baudrate, the longer a firmware update takes.

If ‘Production Mode’ is set to ‘serial port with UBX protocol’, check the UBX protocol baudrate( u-center
automatically initializes it with the u-center baudrate.). The UBX protocol baudrate is only used to enter the
download process.

Initiate the download by pressing the ‘Update’ button. The GPS receiver will be reset automatically after the
download.

AMTARIS Flash Firmware Update E |

Firrmware image

T:

Prodztub lozation

wc-timlptdeborafazhrun. bin j _I

T:

Senal interface part IEEIM'I "l at baudrate |1'|52E|D "I

To enter Production Mode:

r

I

\uc_v2_ldhATROEZ0Lexe _|

uze bootmode pin [on GPS evaluation bow: press boot button while
cycling power or pressing the reset button, then start the update)

uze BTS /DR [make sure that the jumpers inthe GRS evaluation
b are injthe carrect pasition]

¥ uge zenial port with UB3 protocal at baudrate IE?‘EDD 'I
Frogress

Update & bart

Figure 43: ANTARIS Firmware update window
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4.11.3 Dump Receiver Diagnostics

3

|1z thiz tool to dump diagnostic information booa
file if u-blox suppart requests vou to do so for
additional info on a bug repaort

Dump Receiver Info to File

Diagrnostics oukput file:
C:hdiagnostic. ubs |:|

Cancel |

4.11.4 GPS Configuration

u-center is capable of getting the actual configuration of a u-blox GPS receiver and storing it to an ASCII text file
containing hexadecimal records. Such a file can be edited and stored to an u-blox GPS receiver again. By clicking
the menu "Tools->GPS Configuration..” of u-center, the GPS Configuration dialog opens. The following
functions are available:

GPS Configuration r5_<|

Configuration file:

Files\w-blox'u-centersCanfigDief. xRS |

[ Store configuration intoBBR /Flazh
[hon-wolatile mermary)

Retries [for every meszage): 1 _I;l

GPS 2 File

Cloze

Figure 44: Screenshot, u-center GPS configuration

o Specify the name of a new configuration file to store current configuration from the u-blox GPS receiver

o Specify the name of an existing configuration file and load this configuration into the u-blox GPS receiver

» Aflag can be set to force storing the configuration into the Battery Backed RAM (BBR) or Flash EPROM.

If reading or writing configuration data fails too frequently, try to increase the number of retries u-center should
do on a single message if one fails.

&~  Sending a configuration to a u-blox GPS receiver may fail due to a baud rate change on the current
serial port of the receiver where sending this configuration to. If this happens, simply change the
u-center baud rate and send the configuration again.

A window shows the progress of data transfer to/from u-blox GPS receivers. Clicking “GPS >> File” closes this
dialog box and opens the progress window showing configurations being polled and stored into a local file.
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Clicking “File >> GPS" opens the same progress window showing the configurations that are sent to the
receiver. This progress window closes after having finished transfer without any error.

The user can abort the transfer by clicking the “Abort” button. It's not possible to close the window unless
transfer has completed or the user aborted it.

&~ Itis not recommended to read/write configuration while the GPS receiver is in sleep mode.

& ConfigTest.txt - Notepad [_ O] <]
File Edit Faormat Help

MON-UER - BA B4 2?8 09 32 2E 31 52 43 34 20 20 4D 61 79 20 31 36 20 32 30 30 33 20 |
CFG-ANT - 86 13 84 00 BB 00 OF 64

CFG-DAT - 86 86 B2 66 A6 0@

CFG-INF - 86 82 68 00 80 00 00 060 00 60 @7 68

CFE-INF - 86 62 88 60 OF A2 40 BF 60 60 80 68
lcFE-MSE - 86 01 06 60 61 01 60 06 60 00

CFG-MSG - 86 61 86 00 F1 04 60 60 00 68

CFG-MAU - 86 83 1C 66 A3 01 18 1C 1C 65 B8 3C 3C 14 E8 83 86 06 A5 17 C8 66 C8 68
CFG-PRT - 86 68 14 00 60 00 60 060 00 60 B0 60 60 08 60 0@ 60 00 60 00 60 60 00 @0
CFG-PRT - 86 60 14 06 A1 06 OB 66 DA 68 GG 6@ 80 25 A0 AP A7 06 A3 0A NG BA A 68
CFG-PRT - 86 68 14 00 B2 00 60 60 DO 68 00 60 60 E1 60 08 67 00 63 00 60 00 00 @0
CFG-RATE - 86 ©8 B6 A0 EB 83 81 80 60 A

CFG-RXHM - 86 11 62 00 68 0@

CFG-TH - @86 10 BC 80 1F 60 66 AG E8 A3 O 6@ 68 A0 B8 A0

CFG-TP - @86 O7 14 680 40 42 OF 60 AQ 86 01 60 61 61 60 00 32 60 34 63 08 60 00 00

4 |

Mz

Figure 45: Content Configuration File

When clicking the “Edit” button in the GPS Configuration dialog, the Notepad editor opens (standard Windows
software). Configurations are stored the following way:

1* line: it contains the version of the ANTARIS® based GPS receiver where the configuration is from. Never
change this line!

For the 2™ line and following each line contains the same: <class ID>-<message ID> - <hexadecimal byte
code of the message>. The byte code consists of class and message IDs (2 bytes), payload length (2 bytes),

payload (payload length bytes). The sync characters and the checksum are not included. They will be
calculated automatically.

Please refer to ANTARIS® Protocol Specification [8] for detailed information and ranges.

4.11.5 Hotkeys

The Tools Menu allows administrating the Hotkeys defined in the Message View. Please refer to Section 4.5.4 for
more information on the Hotkeys.

4.11.6 Preferences

The Preferences tool can be used to configure a number of u-center parameters.
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Generic ]Workspace] Colors | Messagebar |

Serial ports
v Automatically [diglconnect if most recently used serial port [dislappears.
v Erurmerate serial ports (this may slow down rmenus).

M aximum number of zenal ports 255;|

Power Management

* Mone  Deny suspend if connected " Disconnect on suspend

Program Options [requires restart]

Database

I aximum number of epochs =00:30:00 at 1Hz rate

Cancel

4.12Window Menu

The Windows Menu is Windows® compliant.
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5 How To

5.1 Change Parameters (Baudrate)

e Connect to receiver.
e Open Message View.
o Select UBX — CFG - PRT

3 Messages - UBX - CFG (Config) - PRT (Ports)

B - CFG [Config) - PRT [Ports]

* Tanget [1-UaRTY -l

Protocalin  |0+1+2 - UBX+NMEA+RT = |
Protocol out |0+1 - UBK+MMEA, |

Baudrate

o000 BS 62 06 00 14 00 01 00 00 00 DO 03 nphi0000000b0O
0g0oc 00 90 00 EL 00 00 97 00 03 00 00 00 00000000000
0018 00 00 DE C2 OOBE

][] [+
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5.2 Save Parameters to receiver non-volatile memory (BBR/Flash)

There are 2 ways to save parameters to the receiver’s non-volatile memory (BBR/Flash).

5.2.1 Saving Parameters with UBX-CFG-CFG

e Connect to receiver.

e Open Message View.

o Select UBX-CFG-CFG window.

o Select “save current configuration” (see Figure 46).

[ Messages - UBX - CFG (Config) - CFG (Configuration)

— | UBx - CFG [Config] - CFG [Configuration]

" Revert to last saved configuration
= " Revert to default configuration

+ Save cunent configuration

" User defined operation

Clear Save

BX

[::::::::::] o000  BS 62 06 09 0D 00 OO0 OO0 00 OO FF FF  pkbOO0000O000%F

£

@ X 3¢ eH

gooc 00 00 00 00 00 00 07 21 AF

[ ]m[mm[m [ U

Figure 46: Saving Parameters (UBX-CFG-CFG)

5.2.2 Saving Parameters with GPS Configuration

e Connect to receiver.
e Open Tools / GPS Configuration.

» Select “store configuration into BBR/Flash” checkbox (see Figure 47).

&~ This only applies when sending configuration files to the receiver.
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File Edit W%iew Player FReceiver | Tools “Window Help

Firrware pdate Antaris ...
Firmware pdate u-bloxs. ..

AlmanacFlus. ..
; nfiguration. ..

Hothews ...
Preferences. ..

GPS Configuration |

Canfiguratian file:

| =L

Stare configuration intoBER /Flazh
[hon-wolatile memary]

Retries [for every meszage): I 'I_IZ:I

GPS>>Fie [ Edi. |

Fiess 6P [ [ Ciose |

Figure 47: Saving Parameters (GPS Configuration)

5.3 Recording/Playing a Log File

u-center allows recording and playing log files. Use the player controls, to record or playback a log file. Select the
log file to be opened through the File Menu tool bar. The series of buttons in the player toolbar can be used to
navigate through the log file. The records will be displayed on the navigation display window, in the same way
that live GPS data is displayed when using u-center.

[2m oD -» K [ H

Eiect Crl+E —
v Skop Zhrl4+-H [
Pause Chrl+P
Record Chrl+R .
Skep Ctrl+Space  ——p Slaw
Flay ChHG Jorernrnr Moarmal — > -
SCan ChH+F L Fast
aato Begin —W
Goko End —=H

Figure 48: u-center player toolbar

New log files can also be created through the menu bar by selecting File/New. Figure 49 shows an example of a
log file.
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Save Chrl+s
Open... e N TR S S
Close

Database Emply

Database Export

Prink... Chrl+P
Print Presview
Print Setup...

Recent Files

Exit

Save in: I&)meTMP j - £ B

[@] Unitled_naos11_140500.ubx
@ COMS _ref,ubx
[ @] com4_kerlink. ubic

My Network File name: I::IZII--H 0
Places

Save as type: Iu-b\ox Log Files [*.ubx]

Figure 49: Example of a Log File

5.4 Conduct Sensitivity Tests

u-center is a useful tool for conducting sensitivity tests of GPS receivers and receiver designs. To do so record a
log file under open sky conditions of the receiver to be tested and an Evaluation Kit as reference. Make sure that
the log files are recorded under the same conditions. Using the Statistic View or Table View windows from
u-center, compare the C/NO values of the five strongest satellites. When using Table view, export the values to a
spreadsheet for analysis.
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5.5 Read/Write Configuration Files

Connect to receiver.
Open Tools / GPS Configuration.
select the name of the configuration file to be read or written.

o Select “File>>GPS” button to read or”GPS>>File” to write configuration files.

File Edit Wiew Player Receiver | Tools Window Help
Firrmware pdate Antaris ...
Firmware pdate u-bloxs, .,
AlmanacPus. ..
nfiguratian. ..

Hotkeys ...
Preferences. ..

GPS Configuration

Canfiguration fils:

Iconfig.txt ;l _I

¥ Stare configuration intoBER /Flash
[non-walatle memory)

Fietries [for even message]: I 1_I:

(orsFie D Eat. |

File > GPS Close |

u-center - User’s Guide
GPS.SW-08007 u-blox proprietary

How To
Page 54



@blox

6 Troubleshooting

NMEA or UBX protocol is not available in the Message View

u-center uses dynamic link libraries (DLL). The installation program will automatically install the required DLL's
into the u-center program directory. Should you try to copy a u-center installation from one location to another,
make sure you also copy the DLL files. Verify, the version of u-center matches the DLL version.

u-center doesn’t display all messages

Make sure the baudrate is sufficient. If the bandwidth is insufficient, GPS receivers based on the ANTARIS™ GPS
Technology will skip excessive messages.

Some serial port cards/adapters (i.e. USB to RS232 converter) frequently generate errors. If a communication
error occurs during while u-center receives a message, the message will be discarded.

u-center looses the connection to the GPS receiver

u-center u-blox GPS receivers have an autobauding feature. If frequent communication errors occur (i.e. due to
problems with the serial port), the connection may be lost as u-center and the GPS receiver will autonomously
try to adjust the baudrate. Do not enable the u-center autobauding feature if the GPS receiver has the
autobauding enabled.

Some COM port are not shown in the port list

Only the COM Ports, that are available on your computer, will show up in the COM Port drop down list. If a
COM Port is grayed out, another application in the computer is using it.

PC is very slow when u-center runs

If a high value of epochs is selected, the display in real-time can not be guaranteed, especially when many
graphical Views are open. u-center does not update minimized Views and Console in real-time. Close or
minimize as many of the graphical Views and Consoles as possible and u-center will run faster.

Logfile / Data are only partly displayed

The number of epochs displayed in u-center is limited in order to allow an efficient analysis of larger logfiles. The
limitation is set to 1800 epochs by default. That means if an epoch is available every second you can analyze
data for as much as 30 minutes. After this time the oldest values are discarded. Data stored to a logfile are not
affected by the database limitation. Please refer to section 3.2.5 Database Limitation for instructions on how to
increase this limit.

When planning long-term observations, it's recommended to start recording a log file before analysis begins.

Output messages are not updated in the Message View

Make sure, the protocol you'd like to receive is enabled. If so, double-click on the desired output message.
Double-clicking on an output message enables or disables the periodic message update if the respective protocol
is active. Alternatively, select the desired input or output message and press the ‘Poll’ button.

If you would like to get UBX-INF () messages in the log file, configure the receiver accordingly with the UBX-CFG-
INF input message.

No logfile is recorded

After a new logfile is created, logging will not automatically start but only after selecting the Record button in
the Player Toolbar.
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Related Documents

[1] GNSS Compendium, Doc No GPS-X-02007

[2] LEA-5 Data Sheet, Doc No GPS.G5-MS5-07026

(3] NEO-5 Data Sheet, Doc No GPS.G5-MS5-07025

(4] TIM-5H Data Sheet, Doc No GPS.G5-MS5-07014

[5] u-blox 5 Protocol Specification, Docu. No GPS.G5-X-07036

All these documents are available on our website (www.u-blox.com).

& For regular updates to u-blox documentation and to receive product change notifications please register
on our homepage.

u-center - User's Guide Troubleshooting
GPS.SW-08007 u-blox proprietary Page 56


http://www.u-blox.com/�

@blox

Contact

For further info, please contact us:

Headquarters

u-blox AG

Zuercherstrasse 68
CH-8800 Thalwil

Switzerland

Phone: +41 44722 74 44
Fax: +41 44722 74 47
E-mail: info@u-blox.com

www.u-blox.com

Offices

North, Central and South America

u-blox America, Inc.
1902 Campus Commons Drive

Suite 310

Reston, VA 20191

USA

Phone: +1(703) 483 3180
Fax: +1(703) 483 3179
E-mail: info_us@u-blox.com

Regional Office West Coast:

Phone: +1(703) 483 3184
Fax: +1(703) 483 3179
E-mail: info_us@u-blox.com

Technical Support:

Phone: +1(703) 483 3185
E-mail: support_us@u-blox.com
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Europe, Middle East, Africa

u-blox AG

Zuercherstrasse 68
CH-8800 Thalwil

Switzerland

Phone: +41 44 722 74 44
Fax: +41 44 722 74 47
E-mail: info@u-blox.com

Technical Support:

Phone: +41 44 722 74 44
E-mail: info@u-blox.com

u-blox proprietary

Asia, Australia, Pacific

u-blox Singapore Pte. Ltd.
435 Orchard Road

#17-01, Wisma Atria,
Singapore 238877

Phone:
Fax:
E-mail:
Support:

+65 6734 3811

+65 6736 1533
info_ap@u-blox.com
support_ap@u-blox.com

Regional Office China:

Room 716-718
No. 65 Fuxing Road
Beijing, 100036, China

Phone:
Fax:
E-mail:
Support:

+86 10 68 133 545
+86 10 68 217 890
info_cn@u-blox.com
support_cn@u-blox.com

Regional Office Japan:

6F Akasaka Yoko Building,
4-8-6, Akasaka Minato-ku
Tokyo 107-0052 Japan

Phone:
Fax:
E-mail:
Support:

+81 3 4360 5343

+81 3 4360 5301
info_jp@u-blox.com
+81 34360 5344
support_jp@u-blox.com

Regional Office Korea:

Room 501, Gyeong Hui Building 109-18,
Samseong-Dong,

GangNam-Gu,

Seoul, Korea 135-090

Phone:
Fax:
E-mail:
Support:

+82 2 542 0861

+82 2 542 0862
info_kr@u-blox.com
support_kr@u-blox.com

Regional Office Taiwan:

Room 305

3F, #181, ZouTze Street

Neihu Dis.

Taipei, Taiwan

Phone:
Fax:
E-mail:
Support:

+886 2 2657 1090
+886 2 2657 1097
info_tw@u-blox.com
support_tw@u-blox.com
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